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Introduction  
The Langmuir and Langmuir -Blodgett (LB) devices availab le from KSV NIMA Instruments 

are efficient and effective in investigating floating monolayers, precise deposition of 

multilayers onto solid substrates or simply as platforms for use in observing surface 

chemistry effects such as the breakdown of an enzyme or the crystalline structure of a 

surfactant. The wide range of available systems and the many modules available make 

customization a charm. If the troughs available do not suit your needs, you can contact 

us about designing a customized trough according t o your specifications.  

To avoid confusion this manual refers to just LB measurements, though Langmuir, 

Langmuir -Schaefer, compression/relaxation isotherms, monolayer kinetics analysis and 

many other experiment types can be operated.  

There are three serie s of LB systems available today, the KSV NIMA Langmuir, KSV NIMA 

Langmuir -Blodgett and KSV NIMA Microscopy systems for upright and inverted 

microscopes. The up to date sizes for each series are listed at 

www.biolinscientific.com/ksvnima . The differences between the systems are mechanical, 

i.e. the same software and interface unit operates all of the LB devices.  

This is the software manual for all of the LB devices, featuring instructions on how to run 

the experiments, how to  analyze  the data and the basics of the theory behind the 

measurements. Make sure to check the device -specific manual for details such as 

physical description, cleaning and the procedures necessary for running the experiments. 

Instal lation procedures are presented in a separate installation manual.  

If any problem would appear for the product, then please contact KSV NIMA support 

department at http://www.biolinscientific. com/ksvnima/services/  or contact a local 

distributor. For further information and for the contact details of the nearest distributor, 

please visit our website at www.ksvnima.com.  

http://www.biolinscientific.com/ksvnima
http://www.biolinscientific.com/ksvnima/services/
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Theory  

Overview  

A) Introduction  

Monolayers, thin organic films of a thickne ss of just one molecule are the source of high 

expectations as useful components in many practical and commercial applications such 

as sensors, detectors, displays and electronic circuit components. With both the 

possibility to synthesize custom organic mo lecules and sophisticated thin film deposition 

technology it is possible to create electrically, optically and biologically active components 

on a nanometre  scale.  

A thin organic film can be deposited on a solid substrate by various techniques. These 

inclu de thermal evaporation, sputtering, electrodeposition, molecular beam epitaxy, 

adsorption from solution, Langmuir -Blodgett technique and self -assembly. The Langmuir -

Blodgett (LB) technique is one of the most promising methods for the preparation of thin 

fi lms as it enables  

(A) precise control of the monolayer thickness,  

(B) homogeneous deposition of the monolayer over large areas and  

(C) the possibility to make multilayer structures with varying layer composition.  

An additional advantage of the LB techn ique is that monolayers can be deposited on 

almost any kind of solid substrate.  

B) Short History of LB - films  

The American statesman and scientist Benjamin Franklin began the history of Langmuir -

Blodgett films. In 1774 he reported the following to the Briti sh Royal Society.  

"At length at Clapman where there is, on the common, a large pond, which I observed to be 
one day very rough with the wind, I fetched out a cruet of oil, and dropped a little of it on the 
water.  I saw it spread itself with surprising swiftness upon the surface. The oil, though not 
more than a teaspoonful, produced an instant calm over a space several yards square, which 
spread amazingly and extended itself gradually until it reached the leeside, making all that 
quarter of the pond, perhaps half an acre, as smooth as a looking glass." 

Had Franklin made some simple quantitative calculations he would have found out that if 

a teaspoonful (2 ml) of oil is spread over an area of half an acre, the thickness of the film 

on the surface of water mus t be less than 2 nm.  

It was not until over a hundred years later that Lord Rayleigh suspected that the 

maximum extension of an oil film on water represents a layer one molecule thick. At the 

same time the foundation for the ability to characterize monolaye rs on an air -water 

interface was set by a German woman called Agnes Pockles. She developed a 

rudimentary surface balance in her kitchen sink, which she used to determine (water) 

surface contamination as a function of area of the surface for different oils.  Publication of 

Pockels´s work in 1891 set the stage for Langmuir's quantitative work on fatty acid, 

ester and alcohol monolayers.  

Irving Langmuir was the first to perform systematic studies on floating monolayers on 

water in the late 1910's and early 1920 's. These studies led to him being awarded the 

Nobel Prize.   As early as 1920 he reported the transfer of fatty acid molecules from water 
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surfaces onto solid supports.   However, the first detailed description of sequential 

monolayer transfer was given seve ral years later by Katherine Blodgett. These built -up 

monolayer assemblies are therefore referred to as Langmuir -Blodgett (LB) films.   The 

term Langmuir film is normally reserved for a floating monolayer.  

After the pioneering work done by Langmuir and Blod gett, it took almost half a century 

before scientists all around the world started to realize the opportunities of this unique 

technique. The first international conference on LB films was held in 1979 and since then 

the use of this technique has been incr easing widely among scientists working on various 

different fields of research. Today, we are in a situation where the production of 

nanoscale organic films with the LB method has slowly started to find possible practical 

applications in many fields. Howev er, even though the ideas for practical applications are 

growing the L and LB films are still mostly used as model systems for example for 

biomembrane research and multilayer coatings.  

Background Information  

A) Surface Tension  

Surface tension is a measurem ent of the cohesive energy present at an interface. All of 

the molecules of a liquid attract each other. These interactions of molecules in the bulk of 

a liquid are balanced so that equal forces attract them in all directions. Molecules on the 

surface of a  liquid however experience an imbalance of forces as indicated below.  

 

Figure 1: The forces acting on liquid molecules near and at the surface.  

The excess energy present at the surface is called surface free energy and can be 

qua ntified as a measurement of energy/area. It is also possible to describe this situation 

as having a line tension or a surface tension which is quantified as a force / length 

measurement. The most common units for surface tension are dynes/cm or mN/m. 

These  units are equivalent.  

The surface is the interface of two fluids. The experiment is referred to as a surface 

tension measurement if it involves a gaseous phase. If two liquids are tested then the 

experiment is referred to as an interfacial tension measur ement. In either case the 
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denser fluid is referred to as the heavy phase  and the less dense fluid is referred to as 

the light phase . Solids also may be described to have a surface free energy at their 

interfaces but direct measurement of its value is not p ossible through the techniques 

used for liquids.  

Polar liquids like water have strong intermolecular interactions and thus have high 

surface tension. Any factor which decreases the strength of the interaction will lower the 

surface tension, and so an incr ease to the temperature of the system will lower surface 

tension. Any contamination, especially by surfactants, will lower surface tension which is 

why researchers should be very concerned about cleanliness and preventing 

contaminants!  

B) Surfactants  

Surfa ctants, or surface -active agents, are a larger class of molecules which have a 

significant technological and biological importance. Generally these molecules consist of a 

hydrophilic (water soluble) and a hydrophobic (water insoluble) component. This 

amphi philic (consists of both hydrophilic and hydrophobic components) nature of 

surfactants is responsible for their behaviour in a solution with the forming of micelles, 

bilayers, vesicles, etc.  and their accumulation at interfaces (air/water or oil/water). Th e 

hydrophobic part usually consists of hydrocarbon or fluorocarbon chains, while the 

hydrophilic part consists of a polar group ( -OH, -COOH, -NH3
+ ,  -PO4

-(CH 2) 2NH3
+  etc.).  

 

Figure 2: The components of an amphiphile. 

The association  behaviour of surfactants in solution and their affinity for interfaces is 

determined by the physical and chemical properties of the hydrophobic and hydrophilic 

groups, respectively. The shape and size of the hydrocarbon moiety and the size, charge 

and hyd ration of the hydrophilic head group are of utmost importance in this respect. 

Depending on the balance between these properties a wide variety of self -assembled 

structures, both at interfaces and in bulk, have been observed. The driving force behind 

the a ssociation is the reduction of the free energy of the system. Therefore, when a 

surfactant comes in contact with water it accumulates at the air/water interface causing a 

decrease in the surface tension of water.  

C) Insoluble monolayers  

There exists a wide  range of surfactants with an amphiphilic nature which drastically 

lower the surface tension of water. Many of these amphiphilic substances insoluble in 

water can, with the help of a volatile and water insoluble solvent, be easily spread on a 

water surface  to form an insoluble monolayer at the air/water interface. These 

monolayers, also called Langmuir (L) films, represent the extreme case when considering 

adsorption to interfaces because all molecules are concentrated in a one molecule thick 

layer at the i nterface. The amphiphilic nature of the surfactants dictates the orientation 

of the molecules at the interface (air/water or oil/water) in such a way that the polar 
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head group is immersed in the water and that the long hydrocarbon chain is pointing 

towards  air, gas or oil.  

 

 

Figure 3: A surfactant monolayer at the air/water interface. 

The hydrocarbon chain of the substance used for monolayer studies has to be long 

enough in order to be able to form an insoluble monolayer. A rule of  thumb is that there 

should be more than 12 hydrocarbons or groups in the chain ((CH 2) n, n > 12). If the 

chain is shorter, though still insoluble in water, the amphiphile on the water surface tend 

to form micelles. These micelles are water soluble, which p revents the build -up of a 

monolayer at the interface.   On the other hand if the length of the chain is too long the 

amphiphile tends to crystallize on the water surface and consequently does not form a 

monolayer. It is difficult to determine the optimal le ngth for the hydrocarbon chain 

because its film forming ability also depends on the polar part of the amphiphile. 

Furthermore, the amphiphile has to be soluble in some organic solvent which is highly 

volatile and water insoluble (to transport the surfactan t to the surface, chloroform or 

hexane is commonly used).  
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Theory of LB Measurements  

A) Surface Pressure  

As was mentioned earlier, the air/water interface possesses excess free energy 

originating from the difference in environment between the surface molec ules and those 

in the bulk. This interfacial free energy is accessible by measurements of the surface 

tension g. The surface tension of water is around 73 mN/m at 20 oC which is an 

exceptionally high  value compared to other liquids and consequently makes water a very 

good subphase for monolayer studies.  

The most common way to transport an amphiphile to the surface  is to dissolve it in a 

volatile non -polar (water insoluble) solvent and then using a micro syringe  to deposit 

onto the surface. The solution spreads rapidly to cover the available area. As the solvent 

evaporates, a monolayer is formed. When the available area for the monolayer is large 

the distance between adjacent molecules is large and their interactions are weak. The 

monolayer can then be regarded as a two -dimensional gas. Under these conditions, the 

monolayer has little effect on the surface tension of  water. If the available surface area of 

the monolayer is reduced by a barrier system (see below), the molecules start to exert a 

repulsive force on each other.  

This two -dimensional analogue of a pressure is called surface pressure, P, and is given 

by the relationship  

P = g - g0 

 
where g is the surface tension in absence of a monolayer and g0 the surface tension with 

the monolayer present.  

 

Figure 4: A Langmuir film balance with a Wilhelmy plate electrobalance measuring the surface 
pressure, and barriers for reducing the available surface area. 
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B) The Langmuir Film Balance  

The trough holding the subphase is usually made of Teflon to prevent any leakage of the 

subphase over the edges. The trough is  thermostatted  by circulating water  in channels 

placed underneath the Teflon  trough. The surface area of the trough can be varied by 

sweeping movable barriers over the surface of the trough. The barriers are made of 

Delrin, a hydrophilic material, and heavy enough to prevent any leakage of the 

monolayer beneath the barrier. The surface pressure and the mean molecular area are 

continuously monitored during the compression.  

The mean molecular area can be determined by monitoring the distance the barriers 

have moved and with the known dimension s of the trough. The surface pressure is 

measured by the Wilhelmy plate -method. In this method a measurement is made by 

determining the force due to surface tension on a plate suspended so that it is partially 

immersed in the subphase (see below). This for ce is then converted into surface tension 

(mN/m or dynes/cm) with the help of the dimensions of the plate.  

 

Figure 5: A Wilhelmy plate partially immersed in a water surface.  

The plate is often very thin and made of platinum, but  even plates made of glass, quartz, 

mica and filter paper can be used. The forces acting on the plate consist of the gravity 

and surface tension downward, and buoyancy due to displaced water upward. For a 

rectangular plate of dimensions l p, w p and t p, of m aterial density rp, immersed to a depth 

h l in a liquid of density   rl, the net downward force is given by the following equation:  

F = rpglpwptp + 2g(tpwp)(cosq) - rlgtlwlhl, 

 
where g is the liquid surface tension, q is the contact angle of the liquid on th e solid plate 

and g is the gravitational constant. The surface pressure is then determined by 

measuring the change in F for a stationary plate between a clean surface and the same 
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surface with a monolayer present. If the plate is completely wetted by the l iquid (i.e. 

cosq = 1) the surface pressure is then obtained from the following equation:  

P = -Dg = -[DF / 2(tp+wp)] =  -DF / 2wp , if wp >> tp 

 
The sensitivity can thus be increased by using a very thin plate. The force is in this way 

determined by measuring the changes in the mass of the plate, which is directly coupled 

to a sensitive electrobalance. The monolayer can also be held at a constant surface 

pressure, which is a computer enabled controlled feedback system between the 

electrobalance and the motor responsible fo r the movements of the compressing barrier. 

This is useful when producing LB films i.e. when the monolayer is deposited on a solid 

substrate.  

There are even other ways to control the area of the monolayer and to measure the 

surface pressure but the constr uctions above are the most commonly used.  

C) Surface Pressure Against Mean Molecular Area Isotherms  

The most important indicator of the monolayer properties of an amphiphilic material is 

given by measuring the surface pressure as a function of the area of water surface 

available to each molecule. This is carried out at constant temperature and is known as a 

surface pressure -  area isotherm or simply isotherm. Usually an isotherm is recorded by 

compressing the film (reducing the area with the barriers) at a constant rate while 

continuously monitoring the surface pressure. Depending on the material being studied, 

repeated compressions and expansions could be necessary to achieve a reproducible 

trace. A schematic p -A- isotherm is shown in below.  

 

Figure 6: Schematic p-A Isotherm (left) and orientation of the surfactants in different phases. 

A number of distinct regions are immediately apparent on examining the isotherm. These 

regions are called phases. As one can see when the monolayer is compressed it can pass 

through several different phases which are identified as discontinuities in the isotherm. 

The phase behaviour of the monolayer is mainly determined by the physical and chemical 

properties of the amphiphile, the subphase temperatur e and the subphase composition. 

For example, various monolayer states exist depending on the length of the hydrocarbon 

chain and the magnitude of other cohesive and repulsive forces existing between head 

groups. An increase in the chain length increases th e attraction between molecules, 

condensing the p -A- isotherm. On the other hand, if an ionisable amphiphile is used the 

ionisation of the head groups induces repulsive forces tending to oppose phase 

transitions.  
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A simple terminology used to classify differe nt monolayer phases of fatty acids has been 

proposed by W. D. Harkins as early as 1952. At large the monolayers exist in the 

gaseous state (G) and can on compression undergo a phase transition to the liquid -

expanded state (L 1). Upon further compression, th e L 1 phase undergoes a transition to 

the liquid -condensed state (L 2), and at even higher densities the monolayer finally 

reaches the solid state (S). If the monolayer is further compressed after reaching the S 

state the monolayer will collapse into three -dimensional structures. The collapse is 

generally seen as a rapid decrease in the surface pressure or as a horizontal break in the 

isotherm if the monolayer is in a liquid state.  

There are also many other critical points in a p -A- isotherm such as   the molec ular area at 

which an initial, pronounced increase in the surface pressure is observed, A i, and the 

surface pressures at which phase transitions occur between the L 1 and L 2 state and the L 2 

and S state.  

Typical isotherms of a fatty acid with a single hydro carbon chain (left) and a phospholipid 

with two hydrocarbon chains (right) are illustrated in the image below. Following the 

definitions above one can see that the fatty acid has three distinct regions gas (G), liquid 

(L1) and solid (S), while the phosphol ipid has an additional almost horizontal transition 

phase (L2 -L1) between the two different liquid phases. This is very common for 

phospholipids and the position of this horizontal transition phase is very temperature 

dependent. As the temperature is incre ased, the surface pressure value at which the 

horizontal transition phase occurs will increase and vice versa.  

 

Figure 7: Typical isotherm of a fatty acid and a phospholipid. 
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D) Deposition  

Apart from being used as a tool for mono layer studies the Langmuir film balance can also 

be used for building up highly organised multilayers of an amphiphile. This is 

accomplished by successively dipping a solid substrate up and down through the 

monolayer while simultaneously keeping the surfac e pressure constant with a computer 

controlled feedback system between the electrobalance measuring the surface pressure 

and the barrier moving mechanism. Consequently, the floating monolayer is adsorbed to 

the solid substrate. In this way, multilayer stru ctures of hundreds of layers can be 

produced. These multilayer structures are commonly called Langmuir -Blodgett (or simply 

LB) films. The deposition process is shown below.  

 

Figure 8: Deposition of a floating monolayer onto a hydrophilic solid substrate. 

LB deposition is traditionally carried out with the monolayer in the solid phase. The 

surface pressure is then high enough to ensure sufficient cohesion in the monolayer, e.g. 

the attraction between the molecules in the monolayer is high enough so that the 

monolayer does not fall apart during transfer to the solid substrate. This also ensures the 

build -up  of homogeneous multilayers. When the surface pressure is too high the increase 

in surface pressure caused by the solid substrate  can be enough to collapse the 

monolayer.  

The surface pressure value that gives the best results depends on the nature of the 

monolayer and is usually established empirically. Amphiphiles can seldom be successfully 

deposited at surface pressures lower tha n 10 mN/m, and at surface pressures above 40 

mN/m collapsing and film rigidity often pose problems.  

When the solid substrate is hydrophilic (glass, SiO 2 etc.) the first layer is deposited by 

raising the solid substrate from the subphase through the monolay er, whereas if the solid 

substrate is hydrophobic (HOPG, silanized SiO 2 etc.) the first layer is deposited by 

lowering the substrate into the subphase through the monolayer.   

There are several parameters that affect what type of LB film is produced. These are the 

nature of the spread film, the subphase composition and temperature, the surface 

pressure during the deposition and the deposition speed, the type and nature of the solid 

substrate and the time the solid substrate is stored in air or in the subphas e between the 

deposition cycles.  
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Figure 9: Different types of deposited LB films. 

The quantity and the quality of the deposited monolayer on a solid support are measured 

by a so -called transfer ratio, t.r. This is defined as the ratio between the decrease in 

monolayer area during a deposition stroke, A l, and the area of the substrate, A s. For ideal 

transfer, the t.r. is equal to 1. Depending on the behaviour of the molecule the solid 

substrate can be dipped through the film until the desired thickness of the film is 

achieved. Different kind of LB multilayers can be produced and/or obtained by successive 

deposition of monolayers on the same substrate (see above). The most common one is 

the Y - type multilayer, which is produced when t he monolayer deposits to the solid 

substrate in both up and down directions. When the monolayer deposits only in the up or 

down direction the multilayer structure is called either Z - type or X - type. Intermediate 

structures are sometimes observed for some LB  multilayers and they are often referred 

to as XY - type multilayers.  

The production of so -called alternating layers which consist of two different kinds of 

amphiphiles is also possible by using highly sophisticated instruments. In such an 

instrument, there is a trough with two separate compartments both possessing a floating 

monolayer of a different amphiphile. These monolayers can then be alternatingly 

deposited on one solid substrate.  

Another way to deposit the monolayer is the Langmuir -Schaeffer (LS) tech nique. This 

technique differs from the vertical technique described above only in the sense that the 

solid substrate is horizontally lowered in contact with the monolayer.  
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LayerBuilder  
The KSV NIMA Interface unit is an interface and nexus point between the computer and 

the various connected devices t hat comprise an LB measurement system. A running PC 

program is required for the proper operation of the KSV NIMA interface unit.  

 

Figure 10: The KSV NIMA interface unit. 

A) Display  

The display shows relevant measurement data. Typi cally the top row shows surface 

pressure and the bottom row shows barrier position. The bottom row displays various 

status notifications, such as Limit  when the barriers have reached their limit switch.  

B) Keypad  

When the LB softwareôs control panel (Manu al Control Unit)  is open, the keypad in 

front of the LayerBuilder can be used to control positions of the barriers and dipper. On 

the left -hand side there are two sets of controls for the barrier positions. The buttons, 

from left to right, are close barrie rs, stop and open barriers. With only one barrier drive 

connected (all systems excluding the Alternate system), the lower set can be used for 

controlling a stirrer if one is connected (the open or close buttons turn on the stirrer, the 

stop button turns th e stirrer off). On the right -hand side there are the controls for the 

dipper. The top - left button lifts the dipper, the bottom - left button lowers the dipper and 

the button on the right stops the dipper.  
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Connections  

Most of the devices used with the LB are  connected to the KSV NIMA interface unit which 

in turn is connected to the computer. The barrier drive, the balance, the dipper and other 

devices with 15 -pin cables connect to the back of the unit.  

 

Figure 11: The back of the KSV NIMA interface unit. 

Connect the 15 -pin cables to the ports from right to left to ensure proper operation. 

Other connections at the back of the unit are the USB -port for connecting to the 

computer running the experiment and the plug for the power cable.  

On the right -hand side of the unit are the connections for various other devices  

 

Figure 12: The side ports of the KSV NIMA interface unit. 
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Software  

Overview  

The main menu of the LB program is the Device Server . From this window  all of the 

functions of the LB system can be accessed no matter which configuration is used.  

 

Figure 13: The Device Server, the main menu of the KSV NIMA LB software. 

There are five icons for quick access to the most commonly us ed features.  

 

 
Langmuir Trough Monitor starts a new static experiment (no 
barrier movement or dipping). 

 
LB Control Software starts a new dynamic experiment (including 
barrier movement and dipping in LB). 

 
Browse LB measurement reviews previous experiments. 

 
System Diagnostics and Calibration identifies and calibrates 
attached devices. 
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Browse Oscillating Barrier Measurements allows calculating 
rheological properties from oscillating barrier measurements. 

The Experiments  menu gives access to the s ame choices.  

 

Figure 14: The Run Experiment window. 

The Manual Control  is used to control the attached devices, such as barriers, balance and 

dipper.  

 

 

Figure 15: The Manual Control Unit window used for controlling attached devices. 
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The Setup  menu is used to select the communication port for the interface unit and 

whether the manual control unit opens automatically.  

 

Figure 16: The Setup window is used to handle communication and the control panel.  

 

A new dynamic experiment is started by pressing the LB Control Software  icon. A 

new static measurement is started by pressing the Langmuir Trough Monitor  

icon.  

 

 

Figure 17: The LB Control Software for running an experiment. 

The acquired data can then be analysed from the Browse LB measurement  

window.  
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Figure 18: The Browse LB Experiments window displays measured data. 

The Browse LB Experiments window is explained in more detail in  section 5. Data 

Reduction and Analysis .  

LB Control Software  

The controls for running an actual experiment are operated from the LB Control 

Software . This opens a menu bar at the top of the screen which can then be 

used to access the various necessary bu ttons and controls. The menu bar also displays 

some readings from available devices.  

 

Figure 19: The left-hand side of the LB Control Software menu bar. 

The left -hand side of the LB Control Software is used for starting a new exp eriment, to 

open various controls and to edit the database or the device parameters.  

The File menu can be used for the following commands.  

New Isotherm: Starts a new isotherm experiment. 

New Dipping: Starts a new dipping experiment. 
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New Alt Dipping: Starts a new alternative trough dipping experiment. 

Exit: Closes the LB Control Software.   

The Edit menu can be used for the following commands.  

Data Base: Opens the Edit Database window. 

Device Parameters: Opens the Device Parameters window. 

The View  menu can  be used for the following commands.  

Experimental Setup: Open the Experimental Setup window. 

Trough1 Graph: Open the Trough1 Graph window. 

Trough2 Graph: Open the Trough2 Graph window. 

Dipping Graph: Open the Dipping Graph window. 

The Controls  menu can be used for the following commands.  

Trough1 and Trough2: Opens the controls for the barriers of the corresponding 
compartment.  

Dipper: Opens the dipper controls window. 

BAM: Opens the Brewster Angle Microscope (BAM) controls window. 

External SPM: Opens the controls for an external surface potential meter. 

Zero SPM: Zeroes the reading from a surface potential meter. 

The controls will only be available for those instruments that are attached. Until an 
experiment is begun, the separate controls window available for the barriers and the dipper 
are the same as those available in the Manual Control Unit. 

The three buttons are for starting a new measurement.  

Iso: Start a new isotherm experiment 

Dip: Start a new dipping experiment 

Alt: Start a new alternative trough dipping experiment 

The Sample Interval field determines the time between readings. 

 

Figure 20: The right-hand side of the LB Control Software menu bar.  

The right -hand side of the LB Control Software displays the readings and posi tions of 

attached devices.  



 

 

 

 

 

 
[ Attension  |   KSV NIMA  |   Q- Sense  |   Sophion ]  

 

   23  

B1 and B2 show the readings from balances one and two. 

Brr1 and Brr2 show the positions of barriers one and two. 

D1 and D2 show the positions of dippers one and two. 

T shows the measured temperature. 

pH shows the measured pH. 

SP shows the measured surface potential. 

AD shows the voltage reading from an A/D-D/A card. 

Status indicates the current status of an experiment.  

Brr1 , Brr2 , D1  and D2  indicate the status of barriers one and two and dippers 

one and two respectively.  

Langmuir  Trough Monitor  

Langmuir Trough Monitor is used when the purpose of the measurement is to 

only record surface pressure or surface potential values as a function of time. 

There is no option for barrier movement or dipping. Langmuir Trough Monitor is 

useful  for example in low volume ISR (Interfacial shear rheology) studies or static studies 

when for example something is added to a static subphase.  

In order to initiate a static experiment, click the Langmuir Trough Monitor icon. This 

opens a menu bar at the t op of the screen which can then be used to access the various 

necessary buttons and controls. The menu bar also displays some readings from 

available devices.  

 

Figure 21: The left-hand side of the Langmuir Trough Monitor menu bar.  

 

The left -hand side of the Langmuir Trough Monitor is used for starting a new experiment, 

to open various controls and to edit the database or the device parameters.  

The File menu can be used for the following commands.  

New Experiment: Starts a new experiment. 

Exit: Closes the Langmuir Trough Monitor.   

The Edit menu can be used for the following commands.  
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Data Base:  Opens the Edit Database  window.  

Device Parameters:  Opens the Device Parameters  window.  

The Controls  menu can be used for the following comm ands.  

Trough1:  Opens the controls for the barriers.  

BAM:  Opens the Brewster Angle Microscope (BAM) controls window.  

External SPM:  Opens the controls for an external surface potential meter.  

Zero SPM:  Zeroes the reading from a surface potential meter.  

The c ontrols will only be available for those instruments that are attached.  

New Experiment  is used for starting an experiment. Clicking the button will open the 

experimental setup.  

Balance 1 Filtering and Balance 2 Filtering determine the level of balance fil tering for 

each balance. The heavier the filtering, the less noise. However, also the response time 

of the balance will be higher. With light filtering, the noise level will be higher but the 

response time shorter.  

The Sample Interval field determines the time between readings. If the data point  

interval is marked as zero, the software will record values at maximum speed. In this 

case, around 8 data points  are recorded each second.  

Max Graph Buffer Size determines how many data points  are plotted in the gra ph. 

Once the limit has been reached, the graph is cleared. A ll the results are still saved.  

Figure 22: The right-hand side of the Langmuir Trough Monitor menu bar.  

 

The right -hand side of the Langmuir Trough Monitor displays the readings and positions 

of attached devices.  

B1 and B2 show the readings from balances one and two. 

T shows the measured temperature. 

pH shows the measured pH. 

SP shows the measured surface potential. 

AD shows the voltage reading from an A/D-D/A card. 

Stat us indicates the current status of an experiment.  
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Device Parameters  

The first time that the LB system is operated, the configuration used must be specified.  

To do so, first open the LB Control Software. You can also access device 

parameters trough the L angmuir Trough Monitor window, but in that case only 

the parameters relevant to Langmuir Trough Monitor experiment are shown.  

 

Figure 23: The Device Parameters button in the LB Control Software.  

Open the Edit menu and select Devi ce Parameters .  

 

Figure 24: The Device Parameters define which LB instrument and devices are present. 

The box Balance1 Probe refers to the probe attached to the balance when only one probe 

is present.  If two probes are present, it  refers to the one in the rear compartment of an 

alternate trough. Select the probe used from the drop -down list and check that the 

Perimeter  value is correct.  If a new probe is used it might need to be added to the 

database, please see section ñThe Datab ase ò for details.  
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The box Balance2 Probe  refers to the probe attached to the front compartment of an 

alternative trough. The second balance can also be used in a standard trough as a second 

balance or in another trough if two different troughs are used wi th the same interface 

unit.  

The box Barrier Type  refers to the mechanics of the barrier moving system. Select the 

appropriate model according to which frame is available.  

The box Dipper Type  refers to the dippers used for deposition experiments. Models so ld 

before 1992 have a different mechanism, if not otherwise stated leave this field as 

Standard model .  

The Usage of balances  box is used to indicate the balance set up. With just one balance 

in one trough select the first option. With both balances in sepa rate trough 

compartments also select the first option. With both balances in the rear trough 

compartment select the second option. With both balances in the front trough 

compartment select the third option.  

The Alternate head parameters  box defines the ph ysical parameters of the alternate 

dipper setup. Be sure to correctly fill in these values as there is a risk of breaking the 

substrate or scratching the surface of the trough!  The parameters are listed below, but 

please see chapter ñAlternate Dipping Experimentò for more information on Alternate 

experiments.  

TurnSpdUp:  Turning speed of dipper above the surface. Choices are 

Default, Minimum, Medium and Maximum.  

TurnSpdDown:  Turning speed of dipper below the surface. Choices are the 

same as for TurnSpdUp.  

I n the InitAltHead,  position with both dippers arms at minimum extension and empty.  

d_h:  Distance between upper clip holder and liquid surface.  

d_d:  Distance between upper clip holder and lower clip holder.  

With the substrate attached to the lower arm, unde r the surface and turning to a new 

position.  

d_umin:  Distance between upper clip holder and trough bridge upper edge.  

With the substrate attached to the lower arm, under the surface and waiting for next 

deposition.  

d_lm:  Distance between substrate top a nd trough bridge lower edge.  

d_u:  Distance between upper clip holder and surface.  

With the substrate attached to the upper arm, above the surface and turning to a new 

position.  

d_um:  Distance between lower edge of substrate and trough bridge upper 

edge.  
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Calibration  

The various devices that can be connected to the interface unit are all 

calibrated from the System Diagnostics and Calibration window  

accessible from the Device Server.  

 

 

Figure 25: The System Diagnostics and Calibration window used for calibrating devices. 

The available devices are listed and some are available for calibration. These are the 

balance, the pH -meter and the alternate dipping head. If there is no Display0 item in 

the Name  column then  check that jumpers  are connected to all empty ports.  

After a calibration is completed, the System Diagnostics and Calibration  and the 

Manual Control Unit  must be closed in order to load the new calibration!  

A) Calibrating the Balance  

The balance should be calibrated at leas t every six months. Use the calibration weight 

provided in your monolayer starter kit or any pre weighted object of about 200 ï 300 mg 

that can be hung from the balance. Select the balance from the list of available devices. 

If two balances are available c heck which one (Balance0 or Balance1) is to be calibrated. 

Click Calibrate .  

 

Figure 26: The Balance Calibration window. 
















































































































































































